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Chapter 1: Introduction to integrations

Chapter 1: Introduction to integrations
xMatters On-Demand reduces incident response time by finding the right person to solve the problem when system
outages require you to manage on-call schedules and escalations.
l
l

l

Reduce downtime: create and automate critical incident processes to get the right people on the job.
Aggregate and consolidate alert views: closed loop integration between xMatters and HP OMi provides a
single view of all alerts, no matter how diverse and distributed your environment may be.
Engage resolution teams: determine message recipients based on on-call schedules, including substitutions
and holidays, specific skill sets, escalation priority, and more.

l

Avoid alert fatigue: reduce the noise with targeted notifications; alerts go only to the people that need them.

l

Manage issues from anywhere: full-featured mobile apps allow you to stay in control wherever you are.

Through communication plans, xMatters can become the voice and interface of an automation engine or intelligent
application. When a management system detects something that requires attention, xMatters places phone calls,
sends messages, or emails the appropriate personnel, vendors, or customers.
xMatters is also persistent, escalating through multiple devices and personnel until someone accepts responsibility or
resolves the problem. Once contacted, xMatters gives the notified person instant two-way communication with the
management system. Responses are executed immediately on the original management system event, enabling
remote updates and resolution.
During the process, every notification, response, and action is logged in xMatters. In addition, xMatters
automatically annotates the original event with status information.

1.0.1 Integration Architecture
The software components in this integration include:
l

xMatters On-Demand

l

HP BSM Operations Manager i software

l

xMatters Integration Agent

The following diagram illustrates the software processes used by this integration:

1
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1.1 System Requirements
The following component versions are supported by this integration, and must be installed and operating correctly prior to
integration.
Integration Component

Version

xMatters On-Demand

5.5.87 or later

xMatters Integration Agent

5.1 patch 4

HP BSM Operations Manager i software

10

1.2 Conventions and Terminology
This section describes how styles are used in the document, and provides a list of definitions.

1.2.1 Conventions
Some instructions appear in the following format: MENU > OPTION; for example, File > Open means click the File menu,
and then click the Open menu option.
Words in bold typically reference text that appears on the screen. Words in monospace font represent the following:
l

text that must be typed into the computer

l

directory and file names

l

code samples

Directory paths
Except where explicitly stated, the directory paths in this document are listed in Windows format. Unix users must substitute
the given paths with the Unix equivalents.
The xMatters Integration Agent installation folder is referred to throughout the documentation as <IAHOME>.
l

On Windows systems, the default is C:\Program Files\xmatters\integrationagent\

l

On Unix systems, the default is /opt/xmatters/integrationagent

1.2.2 Terminology
The following terms are used through the xMatters documentation.
Documentation terminology
Term

Meaning

Event

An event refers to any situation or item of interest detected by the management system, and which
requires attention. Event is also used to refer to the incident or situation as it progresses through the
xMatters system, from injection to notification to resolution. Each event must generate at least one
alert or notification.
Event can also be a generic term used to refer to an incident, change request, message, or other
specific item within the management system. Whenever possible, these situations are referred to
using the management system's preferred terminology, but can also collectively be called events.
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Term

Meaning

Management system A management system is any sort of monitoring or managing software that watches for events, and
with which xMatters can combine; i.e., a synonym for HP OMi.
Device

The medium through which a recipient is contacted by xMatters; i.e., email, pager, phone,
BlackBerry, etc.

User

In xMatters, people who can receive notifications are called "users". Each person in the xMatters
system is defined by a set of user details, including ID number, user name, login password, and so
on.

Group

Groups are used to collect and organize users and devices into notification schedules. For a
complete explanation of groups in xMatters, see the online help, accessible from anywhere within
xMatters On-Demand.
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Chapter 2: Installation and Configuration
This chapter provides information about installing the xMatters On-Demand for HP BSM Operations Manager i software
integration. This chapter also contains complete instructions on how to configure xMatters, HP OMi, and the integration
components.

2.1 Installing the integration
This section describes how to install the components required by the xMatters On-Demand for HP BSM Operations Manager
i software integration.

2.1.1 Integration components
The following table describes some of the notable components in the integration archive file:
Integration components
Component Name

Description

configuration.js, hpomi.xml

The JavaScript and XML service configuration files that defines the integration
services on the Integration Agent.

HPOMi.zip

Contains an exported communication plan and forms.

conf/deduplicator-filter.xml

The filtering mechanism used to suppress duplicate messages. The filter checks the
values of certain parameters within injected events; if they are all the same within a
specified time frame, only the first message will be sent through to xMatters. You can
customize these settings by adding or removing predicates in the filter, changing the
suppression period or the number of messages that are compared by the Integration
Agent.
For more information about this feature, see "Filtering and suppression" on page 17.

2.1.2 Installing voice files
These files must be installed into any xMatters deployment running a voice device engine.
This integration provides a number of English voice files (.vox) customized for this integration and HP OMi. The files are
located in the /components/xmatters/vox folder in the extracted integration archive.
To install the voice files:
1. Log in to xMatters as a company administrator.
2. Click the Developer tab.
3. In the Phone Recordings menu, click Add Phone Recording.
4. On the Add a Phone Recording page, specify the following settings:
l

Recording Phrase: A HP OMi Event

l

Event Domain: applications

5. Click Save.
6. On the Edit Phone Recording Details page, click Add New.
7. On the Add Phone Recordings page, click Choose File.
8. Navigate to \components\xmatters\vox, and select A HP OMi Event.vox.
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Note:

The names of the recordings you type into the web user interface MUST match the names of the files; file names are
case-sensitive, and spacing must be respected.

9. Click Open.
10. Click Save.
11. Repeat steps 3-10 for each of the remaining .vox files in \components\xmatters\vox.
l

Ensure that all files are added to the applications event domain.

2.1.3 Adding the web service and REST API users
Adding the web service user
This integration requires an xMatters web service user with permission to receive APXML in xMatters to receive user
responses and notifications about event status changes. The following steps describe how to configure the default web service
user, IA_User, for this integration.
To set up a web service user:
1. In xMatters, click the Users tab, and then click Find Web Service Users.
2. On the Find Web Service Users page, click All.
3. In the returned search results, click IA_User.
4. On the Details for IA_User page, confirm that the list of Allowed Web Services includes the following web services. If
any are missing, select them in the Denied Web Services list, and then click Add:
l

Receive APXML

l

Register Integration Agent

5. Click Save.

Adding the REST API user
To send, delete, and query events, the integration requires a separate xMatters user with permissions to access the integration's
forms. By default, users with the Full Access User role have these permissions. To change this (for example, to limit the
access to a specific user), you can modify form permissions.
To set up a REST API user:
1. In the xMatters web user interface, click the Users tab.
2. Click Add User.
3. On the Add a User page, specify the following settings:
l

User ID: Type the value you configured as INITIATOR_USER_ID in the configuration.js file. The default is
"hpomi".

l

First Name: HP

l

Last Name: OMi

4. Select Full Access User from the Available Roles list, and then click Add.
l

The role you select must match the role configured under Permissions in the integration's forms.

5. Click Save.
6. On the Change Web Login page, specify the following settings:
l

l

Web Login ID: Type the value you configured as INITIATOR in configuration.js file. The default is
"hpomi".
New Password and Verify New Password: Type the password you encoded in INITIATOR_PASSWORD_FILE.

7. Click Save.

Chapter 2: Installation and Configuration | 5

xMatters On-Demand for HP BSM Operations Manager i software

2.1.4 Importing the communication plan
The integration package includes a .zip file that was created using the xMatters "Export Plan" feature; this greatly simplifies
the xMatters configuration process by enabling you to create the integration communication plan, forms, event properties, and
responses in a single step.
To import the communication plan:
1. Log in to xMatters as a company administrator, and click the Developer tab.
2. In the Manage Communication Plans menu, click Import Plan.
3. In the Import Communication Plan File dialog box, click Choose File, and then locate the
\components\xmatters\plans\HPOMi.zip file extracted from the integration archive.
4. Click Open, and then click Import Plan.
5. Click Plan Disabled to enable the plan.
6. In the Edit drop-down list, select Forms.
7. In the New Incident Alerts form, in the Not Deployed drop-down list, click Create Event Web Service.
l

After you create the web service, the drop-down list label will change to Web Service Only.

8. In the Web Service Only drop-down list, click Permissions.
9. Enter the REST API user you created in "Adding the web service and REST API users" on page 5.
10. Click Save Changes.

Accessing web service URLs
To get the web service URL for a form, in the Web Service Only drop-down list, click Access Web Service URL. Copy the
highlighted URL at the top of the dialog box.

2.1.5 Installing the integration service and updating the Integration Agent
To configure the Integration Agent for the HP OMi integration, you must copy the integration components into the
Integration Agent; this process is similar to patching the application, where instead of copying files and folders one by one,
you copy the contents of a single folder directly into the Integration Agent folder (<IAHOME>). The folder structure is
identical to the existing Integration Agent installation, so copying the folder's contents automatically installs the required
files to their appropriate locations. Copying these files will not overwrite any existing integrations.
If you have more than one Integration Agent providing the "hpomi-3-0" service, repeat the following steps for each one. If
you are not certain of the settings required in this section, consult your HP OMi administrator.
Note:

If you have already installed an existing integration, ensure that you backup the deduplicator-filter.xml file
(if one exists) in the <IAHOME>\conf folder before you install this integration.

To install the integration service:
1. Copy all of the contents, including subfolders, of the \components\integration-agent\ folder from the extracted
integration archive to the <IAHOME> folder.
2. If you backed up an existing deduplicator file as indicated in the note above, merge the contents of your back up with
the newly installed <IAHOME>\conf\deduplicator-filter.xml file: open both files in a text editor, and then copy
the <filter> node from the backup file into the new deduplicator file after the last </filter> node. Save and close the
file.
3. Open the <IAHOME>\conf\IAConfig.xml file and add the following line to the “service-configs” section:
<path>hpomi-3-0/hpomi.xml</path>

4. Open the <IAHOME>\integrationservices\hpomi-3-0\configuration.js file and modify the following variables:
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Setting

Description

OMI_SERVER

To configure this setting, replace the default value of "localhost" with
the fully qualified DNS name of the HP OMi Gateway server. The
default value is:
localhost

OMI_PROTOCOL

The protocol used for HP OMi connectivity; the default value is "http".
To enable SSL communication, replace the default value with "https".

OMI_PORT

To configure this setting, replace the default value of "80" with the port
number of your HP OMi server.

OMI_USER

Specifies the username of the web services client account to use when
connecting to the HP OMi web services; the default value is
"xMatters". Note that this user name is case-sensitive, and must match
the name of the defined connected server.
For more information, see "Creating a connected server" on page 9.

OMI_PASSWORD_FILE

Specifies the location of the password file containing the web services
user's password; for instructions on how to set the password for this
user, see "Installing the integration service and updating the Integration
Agent" on page 6, below.

OMI_REST_SYNC_EVENT_ROOTPATH

Specifies the endpoint used to obtain more event details when an Opr
Event Change object is received; the default value is:
/opr-gateway/rest/synchronization/event/

OMI_REST_SYNC_EVENT_CHANGE_
ROOTPATH

Specifies the endpoint used to send Opr Event Change objects to HP
OMi, which reflect response choices made by xMatters Users and are
intended to update events accordingly; the default value is:
/opr-gateway/rest/synchronization/event_change/

DEDUPLICATOR_FILTER

Specifies the name of the filter used by the Integration Agent's
deduplicator module, which prevents duplicate events from being
injected into xMatters; the default value is "hpomi-3-0".
Note that the deduplication filter is cleared whenever the Integration
Agent is restarted; this means that after a restart, events that would
otherwise be filtered may be injected into xMatters.

ANNOTATE_DELIVERY

Specifies whether xMatters should update the originating event with
delivery annotations; the default value is "true".

XMATTERS_FORM

The web service URL of the "HPOMi" form imported as part of the
communication plan; for instructions on how to retrieve this URL, see
"Accessing web service URLs" on page 6.

XMATTERS_FYI_FORM

The web service URL of the "HPOMi-fyi" form imported as part of the
communication plan; for instructions on how to retrieve this URL, see
"Accessing web service URLs" on page 6.
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Setting

Description

INITIATOR

Specifies the web login ID of a separate xMatters user for
authenticating REST API requests. The user (or its role) must have
permission to access the integration's forms via the REST API.
For more information, see "Adding the web service and REST API
users" on page 5.

INITIATOR_PASSWORD_FILE

Specifies the location of the file containing the password of the
xMatters initiator user.
Note: This password file must be created using the IAPassword utility,
as explained in "Setting web services user password", below.

INITIATOR_USER_ID

Specifies the user ID of xMatters initiator user that authenticates REST
API calls.

5. Restart the Integration Agent.
l

On Windows, the Integration Agent runs as a Windows Service; on Unix, it runs as a Unix daemon.

2.1.6 Setting web services user password
This integration includes an encrypted file, located in the <IAHOME>\conf folder, that stores the password for the web
services user required for the management system. You will need to update the file with the correct password for the
SERVICE_DESK_USER variable specified in the hpomi-3-0\configuration.js file.
Password file name:
l

hpomi30.pwd stores the password for the SERVICE_DESK_USER user used by the hpomi-3-0 integration service. If
you change the name of this file, you must also update the configuration.js files to point to the correct password

file.
To specify a web service user password:
1. Open a command prompt, and then navigate to <IAHOME>\bin.
2. Run the following command, where <new_password> is the password for the web services user specified in the
configuration.js file, <old_password> is the existing password (the default value for a newly installed integration
is "password"), and <filename> is the name of the password file (default is hpomi30.pwd).
iapassword.bat --new <new_password> --old <old_password> --file conf/<filename>.pwd

To configure the xMatters REST API user password:
1. Open a command prompt, and then navigate to <IAHOME>\bin.
2. Run the following command, where <new_password> is the password for the INITIATOR user specified in the
configuration.js file, and <old_password> is the existing password (the default value for a newly installed
integration is "password"):
iapassword.bat --new <new_password> --old <old_password> --file conf/.initiatorpasswd

2.2 Configuring HP OMi
The following sections describe how to configure HP OMi to combine with xMatters.
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2.2.1 Creating a connected server
Configuring a connected server allows notification responses to update events appropriately.
To create a connected server:
1. In the HP OMi interface, on the Administration tab, in the Setup and Maintenance area, click Connected Servers.
2. Click the New Item icon, and then select the External Event Processing server type.
l

HP OMi displays the Create New Server Connection dialog box.

3. On the General page, in the Display Name field, type xMatters, and then click Next.
4. On the Server Properties page, type the fully qualified DNS name of the server on which the xMatters Integration
Agent is installed, select Management System as the CI Type, and then click Next.
5. On the Integration Type page, select Call External Event Web Service.
6. In the Root URL Path field, type /http/applications_hpomi-3-0, and then click Next.
7. On the Outgoing Connection page, ensure that the value in the Port field (default for the integration is 8081) matches
the service-gateway port defined in the IAConfig.xml file.
8. If the Integration Agent and xMatters have not been configured for SSL, clear the Use Secure HTTP check box.
l

For more information about secure HTTP, see "Configuring SSL" on page 17.

9. Select the Supports Synchronize and Transfer Control check box, and then click Next.
10. On the Event Drill-down page, click Next.
11. On the Incoming Connection page, enter the password specified in the configuration.js (see "Installing the
integration service and updating the Integration Agent" on page 6).
12. Click Finish.

2.2.2 Creating an event forwarding rule
Each deployment of the integration requires a unique event forwarding rule, specific to each deployment, based on the
organization's assessment of which events are appropriate to be sent to xMatters. An organization can choose to have more
than one event forwarding rule, but for the integration to function correctly, an Event Forwarding rule must exist and be
associated with the xMatters connected server..
The following steps provide an example of how to create a forwarding rule; the rule required for your integration will not be
precisely the same.
To create an event forwarding rule:
1. In the HP OMi interface, click the Administration tab drop-down list, and then click Event Forwarding in the
Automation section.
2. On the Event Forwarding page, click the New Item icon.
l

HP OMi displays the Create New Event Forwarding Rule dialog box.

3. In the General section, in the Display Name field, type xMatters Event Forwarding Rule.
4. In the Condition section, click the Browse button beside the Event Filter drop-down list.
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5. In the Select an Event Filter dialog box, click New, and then select New Simple Filter.
6. In the Filter Configuration dialog box, in the Filter Display Name field, type xMatters Minor Severity Filter.
7. Select the Minor Severity check box, and then clear the check box for all other severities.
8. In the Correlation area, select All top level events, and then click OK.
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9. Once HP OMi returns you to the Select an Event Filter dialog box, with the xMatters Minor Severity Filter selected,
click OK.
10. In the Target Servers drop-down list, select xMatters, and then click Add target server (the plus symbol beside the
drop-down list).
11. In the Forwarding Type drop-down list, select Synchronize.
12. Click OK.
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Chapter 3: Integration Validation
After configuring xMatters and HP OMi, you can validate that communication is properly configured. It is
recommended that you start the components in the following order:
l

HP BSM Operations Manager i software

l

xMatters Integration Agent

Consult the respective user manuals for details on starting these applications.
The following sections will test the combination of xMatters and HP OMi for notification delivery and response.

3.1 Triggering a notification
The following example illustrates how moving an event to "In Progress" will trigger a notification in xMatters.

3.1.1 Inject a sample event
You can use the packaged sendEvent.bat script to inject a test event into HP OMi.
On Windows, this script is located at:
C:\HPBSM\opr\support

For information on how to use the sendEvent.bat script, please refer to the HP OMi documentation.

3.2 Responding to a notification
This section describes how to respond to a notification from xMatters. In the following example, the notification is
received via email, but the process is similar for all devices.
To respond to a notification:
1. When a notification arrives, open it to view its details:
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2. To respond to the notification, click a response choice, and xMatters will update the event in HP OMi.

For more information about response choices, and changing the options available to users, see "Response choices" on page
15.

3.3 Viewing response results
When the response is received, the Lifecycle state is changed to In Progress and a message is logged in the Annotations tab
of the event.
To view the notification results:
1. Open the HP OMi Web Console.
2. On the Event Perspective tab, under Event Browser, locate the event used for testing notifications.
l

The Life Cycle State has changed to In Progress, indicating that the event was acknowledged from xMatters:
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3. To display the messages annotated to the event, click the Annotations tab.
l

An annotation indicates that the event was changed to "In Progress" by bsmith. For In Progress, Resolved, and
Closed responses, the Assigned User is set to the person who responded.
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Chapter 4: Optimizing and Extending the Integration
This section describes some of the available methods you can use to optimize or extend the xMatters On-Demand
for HP BSM Operations Manager i software integration.

4.1 Adding new parameters
Additional data elements (or tokens) can be forwarded to xMatters by adding them in HP OMi. The following steps
explain how to add a new event token to the event injected to xMatters.
Note:

For more information about which parameters may be available, refer to the HP OMi documentation.

To add an event parameter:
1. Open the <IAHOME>\integrationservices\hpomi-3-0\hpomi-request.js file.
2. To add a new child node to the generated APXML data, locate the function convertOprEventToAPXML:
function(event).
3. Locate the following comments:
// add custom tokens
// apxml.setToken("custom_token", event.custom_token);

4. Uncomment the apxml.SetToken line.
5. Save and close the file.
Note that the above token, event.custom_token, is an example. This value must be changed to a valid Opr Event
type which represents a field for an HP OMi event. A description of an Opr Event object can be found in the HP
Business Service Management Operations Manager i Extensibility Guide.
You can now add the new parameter as a property to the communication plan form and add content to notifications.

4.2 Response choices
This integration allows recipients to respond to notifications with several default choices configured on the
communication plan form: Work On, Ignore, and Resolved. Responses are injected back to the HP OMi server,
updating the original event. Users notified on email Devices also have the ability to respond with an extra
annotation message which will be logged in the original event, as described in "Adding annotation messages",
below.
The following is a list of the available response choices and their associated actions on the event in xMatters and
the HP OMi event.
Response

HP OMi Update

xMatters Job Control

Work On

Moves the Lifecycle State of the event to "In
Progress", and annotates the event with the name of
the responder and the device used.

Delink all except responder

Ignore

Annotates the event with the name of the responder
who ignored the notification and the name of the
device used.

Notify next, delink
responder.

15

xMatters On-Demand for HP BSM Operations Manager i software

Response

HP OMi Update

xMatters Job Control

Resolve

Moves the Lifecycle State of the event to
"Resolved", and annotates the event with the name
of the responder and the device used.

Delink all except responder

Job control definitions
The xMatters job controls in the above table are defined as follows:
l

Delivered: marks the notification as delivered.

l

Notify next: notifies the next recipient in the Group according to the defined escalation in xMatters.

l

l

l

Delink responder: marks the notification as delivered, and stops the responder from performing any further action on
the notification.
Delink all except responder: marks the notification as delivered, and stops any recipients other than the responder from
performing any further action on the notification.
Delink all: marks the notification as delivered, stops any further action on the notification for all recipients, and
terminates the event in xMatters.

The job control defined for each response choice is the default configuration for this integration; for more information about
job control, and how to modify these actions in the scripts, see the xMatters Online Developer's Guide.

4.2.1 Adding annotation messages
Two-way email device notifications (not FYI) can add extra annotations that will be added to the HP OMi event as a
message on the Annotations tab. To add an extra annotation, respond to an email notification with the following format in
the subject line:
RESPONSE <Choice> <Message>
<Choice> can be any of the response choices listed in the table above, and <Message> can be any content you want to add

as the annotation.

4.2.2 Responses for FYI notifications
FYI notifications do not have any response choices available, except for FYI notifications sent to voice Devices. Voice FYI
notifications offer the following response choices so that Users can navigate between multiple notifications. (This navigation
is not required on other Devices.)
Voice Device responses for FYI notifications
Response Description

Delete

Removes the notification from the User’s list. This option is most likely to be selected.

Save

Saves the notification and stops attempting to deliver it to the User’s other Devices. Users may select this
option to delay listening to the notification when it is delivered, and access the details by calling in, or via the
xMatters web user interface, at a later time.

Repeat

Replays the notification content.
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4.3 Annotations
This integration extensively annotates the originating HP OMi event with messages regarding the delivery status of
notifications from xMatters, but this may not be desirable in all environments. To prevent annotations, change the value of
the ANNOTATE_DELIVERY variable in configuration.js to false..

4.4 Filtering and suppression
The xMatters Integration Agent's Portable Filtering and Suppression Module is a built-in module that maintains a rolling
record of previously injected events, and allows for the suppression of duplicates (also referred to as "deduplication"). This
helps avoid disruption of traffic due to inadvertent loads that can result when, for example, improperly configured
management systems inject duplicated events.
The deduplicator-filter.xml file is installed in the <IAHOME>\conf folder and is configured to suppress duplicate events
for 12 hours (up to a maximum of 100 events in that period).
This filter can be modified to extend the time period over which an event is considered to be a duplicate, the number of
events in that period and the tokens that are used to determine what makes the event unique.
For example, to add category to the tokens, open the deduplicator-filter.xml file in a text editor and add the following
line to the <predicates> collection:
<predicate>category</predicate>

Save the file and restart the Integration Agent for the changes to take effect.
Note:

To see a complete list of predicates available in the integration, reviewing the Event Data in the Event Summary
Report in the xMatters web user interface.

4.5 Configuring SSL
This integration supports SSL communication between the Integration Agent and HP OMi and between the Integration Agent
and xMatters.

4.5.1 Using self-signed certificates
The SSL support has been configured out of the box to support self-signed certificates. This is not recommended for
production systems due to security reasons, unless you are aware and accepting of the security implications of self-signed
certificates.
To modify the SSL configuration:
1. Open the <IAHOME>\integrationservices\hpomi-3-0\lib\javascript\webservices\wsutil.js file and
modify the ACCEPT_ANY_CERTIFICATE variable as follows:
l
l

Set to true to use SSL but trust any certificate (including self-signed ones).
Set to false to accept only Certificate Authority (CA) certified certificates (recommended in production
environments).

4.5.2 Importing certificates
The next step required to enable SSL support is to import the certificate used by the HP OMi web server to the cacerts
keystore of the Java Virtual Machine (JVM) bundled with the Integration Agent.
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Using the keytool executable located at <IAHOME>\jre\bin, execute the following command on the Integration Agent to
import the certificate, replacing the variables with the appropriate values as described in the list below:
keytool -import -alias <your.alias> -file <path>/<certificate>.cer -keystore
<dir>/jre/lib/security/cacerts -storepass <password>
l

<your.alias>: an identifier for the certificate within the keystore; for example, you can use the string "hpomi-3-0".

l

<path>: path to the certificate

l

<certificate>: the certificate’s file name

l

<dir>: the directory in which the Integration Agent is installed.

l

<password>: the password for the cacerts keystore; the default password is "changeit".

If you want to configure SSL support between the Integration Agent and xMatters, use the above command to import the
trusted certificate for xMatters into the Integration Agent keystore (for information on setting up SSL in xMatters, consult the
xMatters Community site at http://support.xmatters.com

4.5.3 Updating HTTP to HTTPS
The next step is to update the OMI_PROTOCOL in the <IAHOME>\integrationservices\hpomi-3-0\configuration.js
file to use the HTTPS protocol instead of HTTP.
The modified value should resemble the following:
var OMI_PROTOCOL = "https";

Note:

For trusted certificates, "localhost" should be replaced with the COMMON NAME (CN) specified in the certificate
and the port should be set to the port specified in the SSL configuration for HP OMi.

To configure the Integration Agent to use HTTPS when communicating with xMatters:
1. In a text editor, open the <IAHOME>\conf\IAConfig.xml file.
2. Modify the URL for the <primary-servers> and <secondary-servers> elements to use the HTTPS protocol instead of
HTTP; the section should resemble the following:
<primary-servers>
<!-| 0 or more URL elements that specify the primary location of each xMatters server's
| RegisterIntegrationAgent Web Service. The URLs must begin with either http:// or https://
| and cannot have a query or fragment component. The URLs must be resolvable from this IA.
+-->
<url>https://localhost:8443/api/services/AlarmPointWebService</url>
</primary-servers>
<!-| These servers are assumed to be connected to the same xMatters database,
| which can be different than the primary servers' database.
+-->
<secondary-servers>
<!-| 0 or more URL elements that specify the secondary location of each xMatters server's
| RegisterIntegrationAgent Web Service. The URLs must begin with either http:// or https://
| and cannot have a query or fragment component. The URLs must be resolvable from this IA.
+-->
<url>https://localhost:8443/api/services/AlarmPointWebService</url>
</secondary-servers>

Note:

For trusted certificates, "localhost" should be replaced with the COMMON NAME (CN) specified in the certificate
and the port should be set to the port specified in the SSL configuration for the xMatters server.
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3. Modify the value for the <service-gateway> element to use SSL; note that the service-gateway host IP must be
resolvable from the xMatters servers:
<service-gateway ssl="true" host="localhost" port="8081"/>

4. Restart the Integration Agent.

4.5.4 Optional Configuration
The following scenarios illustrate the common configuration options available when using SSL.

Scenario 1
l

HP OMi certificate: CA-certified

l

xMatters certificate: CA-certified

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to false.
This will ensure ALL communication between the Integration Agent and HP OMi and the Integration Agent and xMatters
uses the appropriate CA certified certificates

Scenario 2
l

HP OMi certificate: CA-certified

l

xMatters certificate: self-signed

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to false.
In xmatterws.js, add the following line at the end of the init() method:
this.ACCEPT_ANY_CERTIFICATE = true;

This will allow communication between the Integration Agent and xMatters to use self-signed certificates while maintaining
more complete security between the Integration Agent and HP OMi.

Scenario 3
l

HP OMi certificate: self-signed

l

xMatters certificate: CA-certified

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to true.
In xmatterws.js, add the following line at the end of the init() method:
this.ACCEPT_ANY_CERTIFICATE = false;

This will allow communication between the Integration Agent and HP OMi to use self-signed certificates while maintaining
more complete security between the Integration Agent and xMatters.

Scenario 4
l

HP OMi certificate: self-signed

l

xMatters certificate: self-signed

In wsutil.js, set the variable ACCEPT_ANY_CERTIFICATE to true.
This will allow ALL communication between the Integration Agent and HP OMi and between the Integration Agent and
xMatters to use self-signed certificates.
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